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October 2020 Updates 

In this lesson, we’re going to cover the updates that were announced at Adobe’s 
MAX conference, which just wrapped up in October of 2020. They released new 
versions of Photoshop, Lightroom Classic and Bridge. 

I’m not going to actually USE the big new features in this lesson. I’m just going to 
make you aware of them. I would rather get into these features in a more in-depth 
manner in future lessons. 

Here, I’m going to cover the smaller new features, as well as the features you’re 
used to using and how they’ve changed, so the updates don’t mess you up in 
your workflow. 

Photoshop’s Major New Features (Timestamp 1:55)

• Neural Filters These filters use artificial intelligence to apply things to your image. 

• Sky Replacement This feature will attempt to automatically select the sky and 
replace it with a different sky. Some replacement skies are included from Adobe. 

• Enhanced Cloud Documents You can now save multiple versions of your doc-
ument.

• Pattern Preview This takes the document you’re currently working with and 
tiles it to fill your screen.

• Live Shapes You can now make changes to shapes (rounded corners, for ex-
ample) after creating them, via the Properties Panel.

• Reset Smart Object Transformations There is now a setting that allows you to 
remove all transformations from a smart object. 

• Plug-Ins menu This a new menu, from which you can access and download 
plug-ins. 

• Preset Search There is now a search field at the top of preset menus for gra-
dients, swatches, etc. 
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• Content-Aware Tracing Tool This new tool will help you do auto-tracing using 
the Pen Tool.

• Select & Mask Enhancements This includes the selection of hair.

• Color Grading in Adobe Camera Raw This will replace the split-toning feature. 
Unlike the split toning feature, where you can only affect the shadows and 
highlights, this color grading feature allows you to change the midtones. It also 
gives you the option to color-grade the entire image. 

• New Help & Learn System 

Adobe Camera Raw New Features (8:10)

• Color Grading Described above

• GPU Accelerated Local Adjustments These local adjustments will work faster 
if you have a supported video card.

• Hide Edit Panels You can now hide these panels so they don’t take up too 
much room in your interface.

• Compact Layout Mode There is a 
new mode that allows the adjust-
ment panels to be more compact. 
By default, the adjustment name 
and number field appear above 
the slider. In this compact mode, 
the name appears to the left of 
the slider and the number field 
appears to the right of the slid-
er. (see screen shot) In this mode, 
the slider itself is shorter, which 
means you can not be as precise 
in making your adjustments. 

You can see the slider layout in standard mode 
(left) vs. compact mode (right).
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• Box Zoom Instead of zooming in by a certain percentage, you can now click 
and drag on the image to define the area you’d like to zoom into.

• New Camera Support (see below)

• New Lens Support (see below)
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Lightroom Classic New Features (12:04)

Note: Lightroom Classic is the version of Lightroom that stores your images lo-
cally on a hard drive. 

• Color Grading (explained above)

• GPU Accelerated Local Adjustments (Just like in Camera Raw, above)

• Tethered Live View for Canon Cameras (see screen shot below)

• Box & Scrubby Zoom Instead of zooming in by a cer-
tain percentage, you can now click and drag on the 
image to define the area you’d like to zoom into. This is 
the Box Zoom. The Scrubby Zoom allows you to hold 
the Shift key and then click with your mouse and drag 
left and right to zoom in and out. The Zoom menu in 
the top corner of the Navigator Panel has been updat-
ed as well. In the past, the menu presented you with 
zoom ratios (Ex: 1:2). Now, it presents you with per-
centages. 

Here, you can see 
the tethered live 
view screen (for 
Canon cameras) 
within Lightroom.

LEFT: The old zoom 
menu. RIGHT: The new 
zoom menu now shows 
percentages.
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• New Camera & Lens Support (Same list as for Camera Raw)

• Name Updated Catalog File The first time you run the new version of Light-
room, you will be prompted to update your catalog file. It will actually create a 
copy of the catalog and then update the copy. In the dialog that pops up, you 
will have the option of renaming this catalog file. 

• UPDATE ACR Don’t forget to update ACR to match Lightroom.

Adobe Bridge New Features (17:55)

• Video Thumbnail Preview If you view video files, you will now be able to see 
previews of them.

• Resize images to fit or fill 

• Rearrange export presets

When updating the 
Lightroom cata-
log, you can now 
rename the new 
catalog file.
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Photoshop & Lightroom: Where’s my Stuff? (19:10)

Now let’s look at some of the smaller changes that have been made, as well as 
changes that have been made to existing features. 

Beta graphic This is just a fun lit-
tle hidden tidbit. If you click on the 
Photoshop menu and choose “About 
Photoshop,” you will see the info 
screen for the current version. When 
the beta testers were testing out this 
version of Photoshop, they saw a dif-
ferent screen. Hold down the Com-
mand key (Ctrl on Win) while clicking 
on the Photoshop menu and choos-
ing that same “About Photoshop” option. Holding down the Command key will 
bring up the fun info screen that the beta testers saw. 

The Help System One of the basic changes was 
to the help system. The keyboard shortcut Com-
mand+F (Ctrl+F on Win) will call up the Discover 
dialog, which allows you to search for features in 
Photoshop. This dialog has changed since the last 
version. I use this dialog the most when I want to 
use a feature but I can’t remember what menu it’s 
hidden under. 

The Discover dialog now contains a Quick Actions 
section that includes shortcuts for removing the 
background on an image, blurring the background, 
and making the background black and white. It 
also has an Enhance Image option. I find that the 
results of these actions are far from perfect and 
leave me with a lot of extra “clean-up” work. 

The Discover dialog
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There is also section called “Hands-On Tutorials.” If you choose one of these, it 
will open the same image that is used in the tutorial so that you can follow along. 
It also allows you to move the Discover dialog box around the screen so that you 
can access all of Photoshop’s features. 

Preset Search Feature Many of the 
panels containing presets now include 
a search field at the top. This allows 
you to quickly search for presets with-
in panels like Swatches, Gradients & 
Patterns.

If you choose one of the Hands-On Tutorials, it will open the same image that’s used in the 
tutorial so you can follow along.

There is now a preset search field at the top of 
certain panels.
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Plugins menu There is a new Plugins menu in the main menu bar at the top of 
the interface. This menu will include any plugins you have installed as well as an 
option to browse plugins within the Creative Cloud app. From here, you can also 
open the new Plugins Panel, which will list all of your plugins and let you work 
with the settings for each one. 

Smart Objects There have also been chang-
es made to smart objects, adding some func-
tionality to the Properties Panel. There is now 
an angle setting, which allows you to rotate 
the smart object without needing to use the 
Transform command. You can either choose 
a rotation from the Angle menu or you can 
click on the angle icon and drag left or right 
to adjust the angle of the smart object. If you 
hold down the Shift key while dragging left 
or right, you will be changing the rotation in 
larger increments. 

The smart object Properties Panel also has a 
new U-turn icon. Clicking this will undo any 
transformations made to the smart object. 
This includes all the settings found under the 
Transform menu (Edit > Transform). 

There is a new 
Plugins item in the 
main menu bar. 
From here, you 
can open the new 
Plugins panel.

There is now an angle setting within 
the Properties Panel for smart objects. 
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Pattern Preview Under the View menu, there is a now choice called “Pattern 
Preview.” A Pattern is something we can create by going to the Edit menu and 
choosing Define Pattern. You could then fill a document with that pattern (Edit 
> Fill) or fill a layer with that pattern by clicking on the Adjustment Layer icon at 
the bottom of the Layers Panel and choosing Pattern Fill from the pop-up menu. 
In the past, you would not see what the repeating pattern looked like until you 
applied it to your document. 

There is now a way of previewing a pattern before applying it. Under the View 
menu, there is a now choice called “Pattern Preview.” Choose this option and you 
will see a repeating view of the document you’re working on, with the document 
itself outlined in blue. 

The Pattern Preview view is shown above. The document that is repeating is outlined in blue.
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You can also interact with the doc-
ument while it’s in this view. If you 
use the Move Tool to move one of 
the layers, you will see it move in 
all of the repeating instances. If 
you move the object off the edge 
of one tile, it will move into the re-
peating tile next to it. This allows 
you to create much nicer patterns. 

You can also create a new layer 
and paint between the tiles and 
the stroke will be repeated across 
the pattern. Know that there are 
limitations with this. You can not 
currently use retouching tools like 
the Healing Brush to clean up the pattern seams. In order to create a seamless 
pattern, you would still need to use the Offset filter.

Camera Raw: Where’s my Stuff? (36:36)

Zooming In Camera Raw, there are now new 
ways of zooming. In the past, you would click 
once on the image to zoom in and then click 
again to zoom out. Now you have more control. 
You can zoom in on a particular area by hold-
ing down the Command key (Ctrl on Win) and 
clicking and dragging out a rectangle on the 
area. When you release the mouse button, Cam-
era Raw will zoom in on that area. Click once to 
zoom back out again. 

In the Pattern Preview view, the Brush Tool is being 
used to paint across the document to add to the 
repeating pattern.

You can now drag out a box to 
zoom in Camera Raw.
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GPU Accelerated Local Adjustments The local adjustments in Camera Raw are 
the Adjustment Brush, the Graduated Filter and the Radial Filter. They were im-
proved with this update so that they work more quickly and are much more fluid 
when interacting with the image. You will need to specify a setting in order for 
this feature to kick in and you can do that within the Preferences. Click on the 
gear icon in the top right corner of Camera Raw’s interface and the Preferences 
dialog will appear. Navigate to the Performance section and turn the “Use Pro-
cessor” setting on. If this setting is grayed out, then it means that your system is 
not new enough to use the feature. 

Color Grading The Split Toning Panel and settings 
have been replaced by the Color Grading Panel. 
This will be covered in greater detail in an upcom-
ing lesson, but I want to make sure you know that 
you can still use this panel to apply split toning to 
your image. To do this, move the Blending slid-
er all the way up to its maximum setting (100). 
Leave the Midtones setting alone and only work 
with the Shadows and Highlights settings. 

There are a few little icons at the top of the Col-
or Grading Panel. The Black icon represents the 
shadows and the white icon represents the high-
lights. Click on these icons (one at a time) and 
then click on the little down-pointing arrow to 
the right of the Hue slider. This will expand the 
settings to include the Saturation and Luminance 
sliders. These are the same sliders that you had 
in the old Split Toning Panel. The Balance slider 
works in the same way as well, determining where 
the shadows end and the highlights begin. 

If you have any split toning presets, you can still 
use them and they will work the same way. 

You can use the Color Grading 
Panel to apply split toning. Make 
sure the Balance slider is set to 
100. When working with the shad-
ows and highlights, expand the 
settings to display the Saturation 
and Luminance sliders.
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Edit Adjustment Panels You can now 
hide any adjustment panels that you 
never use. Right-click on the name of 
a panel and choose “Edit Panels to 
Show” from the pop-up menu that 
appears. This will open a dialog that 
contains a list of all the adjustment 
panels. Use the check boxes to the 
left of each panel name to determine 
which ones will be visible in your in-
terface. 

Compact Layout Option This was mentioned 
briefly at the beginning of this lesson, but there 
is now an option to make the adjustment pan-
els more compact. In this mode, the sliders are 
shorter and the slider names and number fields 
appear alongside the sliders instead of above 
them. This can be useful if you are using Camera 
Raw on a very small screen. Access this view by 
right-clicking on the name of a panel and choos-
ing the Compact Layout option from the pop-up 
menu.

New Features in Lightroom (42:21)

Zooming It used to be that you would click once on your 
image to zoom in and then click again to zoom out. Now, 
just like in Camera Raw, you can hold down the Command 
key (Ctrl on Win) and drag out a rectangle on your im-
age. When you release the mouse button, Lightroom will 
zoom the image in to the area you circled. Click anywhere 
within the image to zoom back out again. 

Use the check 
boxes in the 
“Edit Panels to 
Show” dialog 
to determine 
which of the  
adjustment 
panels will be 
visible in your 
interface.

Choose the Layout view by 
right-clicking on a panel name.

You can now zoom in by 
dragging a box around 
the area.
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Unlike in Camera Raw, there is a second new way of 
zooming your image. This works when you are view-
ing your image in the Develop Module. Hold down 
the Shift key and you will see your cursor turn into a 
magnifying glass icon with left and right arrows next 
to it. With the Shift key held down, you can click and 
drag left and right in order to zoom in and out on 
your image. Dragging right will zoom in and drag-
ging left will zoom out. This is called the “scrubby 
zoom.”

Reducing the size of the Catalog file Whenever you update to a new version of 
Lightroom, a new catalog file is created. The old catalog file will remain in the 
folder and you may notice that the file size can be quite large. I suggest taking 
this old catalog file, compressing it and then moving it to an external hard drive 
to use as a backup. This will free up room on your computer’s hard drive.  

After you’ve launched the new version and it has updated your Lightroom cata-
log file, I would suggest that you click on the Lightroom menu and choose Cata-
log Settings. (This will be found under the Edit menu on Windows.) In the dialog 
that appears, it will show you the location of the catalog file. Click on the Show 
button to the right of the location and it will open the Finder to show you the 
folder containing the catalog. Open this folder to see all of the catalog files, in-
cluding any old catalog files.

Right-click on the file name of an old catalog and choose Compress from the 
pop-up menu. This will compress the file in a lossless manner, where it does not 
degrade the quality of what’s stored inside. Now you can take that compressed 
catalog file and move it to a different hard drive. I move it to the same hard drive 
that contains the original pictures. This will serve as my backup catalog. You can 
then delete the original file so that it’s not taking up space on your hard drive. 

The scrubby zoom icon in 
Lightroom


